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Introduction 
Not really.  Microsoft Word 20161 (“Word”) has immense capabilities out of the box for 
attorneys and legal professionals.  Most of the tools are available from the ribbon or from 
menus that come from the ribbon.  Out of all of the tools and features in Word that are 
discussed in this article, there is only one that is truly “hidden”.  As detailed below, this 
article discusses styles, the major Word feature that attorneys should be using to make 
document creation and editing with Word more efficient and less frustrating.  Let’s get 
started! 

First Things First – Don’t be Afraid to See the Whole Picture 
Show/Hide Trigger 
Turn this on while drafting!  The Show/Hide Trigger is the button in the Home Tab of the 
Ribbon that looks like the traditional paragraph mark (¶).  This trigger allows you to see 
the non-printable characters in a document.  These non-printable characters include all 
manner of items, including spaces, tabs, paragraphs, non-breaking spaces, page breaks, 
section breaks, etc., etc.  Having this triggered is key to really understanding how your 
document is actually working. 

Styles 
Styles are probably the most important tool in Word.  Simply put, a Style is a pre-set format 
for any part of your document.  Styles are so important, they the quick access bar to Styles 
take up about half of your default Home Tab in the Ribbon.  Most Word users forgo 
understanding Styles, because to really use them, a user would have to open the Styles 
menu, which is not necessarily intuitive.  This does not mean that the Styles quick access 
bar is not useful – it definitely is – however, to really utilize Styles, the quick access bar is 
not enough.  In Word, to easily access the Styles Pane, click on the small box with an arrow 
in the bottom right hand corner of the quick access bar.   

The Quick Access Toolbar only provides a limited view of the styles available in any specific 
document.  Some styles are hidden by default, while the Normal, Headings, and some other 
styles are readily visible.  The Styles Pane provides a look into some or all of the Styles in a 
document.  To see every possible Style, selection “Options”, and choose “All Styles” under 
the drop down for “Select styles to show”.  For most users, the first time they do this exercise, 
they realize something that helps frame the importance of Styles in Word:  there is a Style 
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of every part of a document, including the Table of Contents, Hyperlinks, Page Numbers, 
Lists, etc.  

Types of Styles 
For the purposes of this presentation, there are two general classifications of styles that 
attorneys and legal professionals should be aware of to really start using Word more 
efficiently.  While these two classifications are not the actual types of styles defined by 
Microsoft, using these two classifications as a substitute will provide most people with the 
functionality they need for drafting legal documents.  These two style classifications are 
Paragraph styles and Heading styles.2  Paragraph styles are the preset formats that will 
make up most of the body text in a document: regular paragraphs, block quotes, signature 
blocks, etc.  Heading styles are just that; they apply preset formatting to the headings in a 
document. However, when using heading styles, a whole world of efficiency opens up as 
discussed below. 

Creating & Modifying Styles 
Word comes with default styles out of the box that comes with the now normalized Calibri 
11-point font.  As most know, legal documents are not drafted or filed using these defaults.  
Most users will then want to simply modify the style.  Modifying a style can be accomplished 
in multiple ways, however only two are highlighted here.   

The first and easiest way is to manually change the font, spacing, etc., that you want and 
then right click the corresponding style in the Style Quick Access Bar and select “Update 
[Style Name] to Match Selection”.  This will then update the Style you selected to match the 
formatting settings you choose.  For the most part, this method works, however, sometimes 
a little more control is needed. 

The second method is to right click a Style that needs updating, either in the Quick Access 
Bar or the Styles Pane and choose “Modify …”.  This will open the Style modification menu, 
which provides specific controls over Font, Paragraph, Tabs, Numbering, etc., for the Style 
selected.  Utilizing this method will ensure that the Style selected will be modified with 
precision.  

 

 

 

 

Once users begin to start using Styles and start understanding the power of Styles, they 
will start creating their own Styles instead of relying on the default Styles already provided 
in Word.  To create a style, open the Styles Pane and click the button that looks like a star 
above the two As.  This will open a similar menu as to the modification menu and the process 
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is similar to modifying a style.  The only two additional tasks are to name the newly created 
style and then identify the type of style it is.  As you will see, Heading is not available, 
however, Paragraph is.  If you desire to create an additional “heading” style, choose the 
“linked” style format. 

Important Options in Modifying or Creating Styles 
The options in modifying or creating styles are too numerous for this paper, however, there 
are a few main options that will enhance the process of using styles in legal drafting.   

Style for following Paragraph 

One feature is the option in the style menu called “Style for following Paragraph”.  Through 
this drop down, you can select which style would be applied for the next paragraph when 
you hit the “Enter” key.  For example, if you know that most of the time you follow your first 
level of heading (aka “Heading 1”) with a paragraph, then selecting the Normal style as the 
“Style for following Paragraph” in the Heading 1 style menu will automatically switch your 
formatting from Heading 1 to Normal.  You can go from one style to another without having 
to use your mouse to click on another style.  This option, although somewhat basic, really 
helps writers stay focused on writing instead of having to choose formatting options.  

Font Format 

In the bottom left hand corner of the style menu is the Format drop down.  Do not be fooled!  
This is the most powerful drop-down menu in the entire style menu.  Through this menu, 
you can select multiple categories of formatting to control your style, including even 
animated text (although that would never be used in a legal document).  Of these, the font 
menu is one of the more important.  Selecting this option will open the entire font menu for 
the style, not just the shortcuts provided for either in the Ribbon or the main style menu.  
There are numerous options in this Font menu that apply to legal documents, including the 
dreaded Small Caps setting that is so hard to find, but needed for most Bluebook citation 
methods.  An Advanced Tab is also included in this menu, which provides specific controls 
over the formatting of your font, including spacing, Kerning, and other special features that 
may or may not be needed.  Once all of the wanted settings are selected, clicking “OK” will 
apply those font settings to your selected style. 

Paragraph Format 

In addition to the Font menu, the Paragraph menu is also a key menu in modifying or 
creating styles.  This menu provides the spacing and indentation options that legal 
documents need, as well as some additional options in the line and page break tab that are 
helpful in dealing with headings and page breaks.  This is also the menu to change Word’s 
default Normal style’s spacing issues, which default to 1.08 spaces between sentences and 
the extra 8-point space between paragraphs, which do not work in legal documents.  As with 
the Font selections, click “OK” will apply any updated paragraph settings to your selected 
style. 



Heading Styles 
Heading styles are considered linked styles that have been tagged to various outline levels 
in Word.  In layman words, this means that heading styles can do a lot!  Modifying the 
default heading styles in Word is similar to modifying paragraph styles.  However, there 
are some options in the Line and Page Breaks Tab in the Paragraph Menu that most 
paragraph styles would not opt for that are primed for heading styles.  These include the 
“Keep with next”, “Keep lines together”, and “Page break before” selections.  “Keep with 
next” is a feature that keeps the current text tied to the following paragraph so that they do 
not appear on separate pages.  This feature is helpful for headings to make sure headings 
do not appear on one page and the content starts on the next page, automatically!  “Keep 
lines together” ensures that all of the current text stays together and does not break across 
pages.  Similar to the former setting, this ensures that a multi-level heading stays all on the 
same page, automatically.  Lastly, “Page break before” inserts a page break, automatically, 
before the text.  This is helpful for those top-level heading styles that are applies to various 
sections of a document. 

The other Font and Paragraph options for Heading styles are the same as for Paragraph 
styles.  However, for those that want to include numbered headings, forego the Numbering 
option in the Style Menu (under Format drop down) and instead use a Multilevel List. 

Multilevel Lists 
Multilevel List are the long ignored third option in the bullets and numbering shortcuts.  
This is unfortunate, as using a Multilevel List is much more powerful and feature rich for 
tiered headings.  Additionally, Multilevel Lists can be linked to styles.  This means that 
adding content in the middle of a document and ensuring the numbering automatically 
adjusts is only a click away, instead of guessing or manually entering a number.  Here is 
how it works.   

The Multilevel List menu is contained in the Home Ribbon to the right of the bullets and 
numbering options.  Selecting this dropdown list will provide a few default and prebuilt list 
styles, however, when customizing styles, why not also customize the multilevel list that is 
going to be linked to the style?  Select “Define New Multilevel List” and a partial menu 
opens.  Select the “More” arrow in the bottom left hand corner of the menu.   This opens the 
full multilevel list menu.   

Selecting each level in the left-hand pane will provide formatting options for each level in 
the list.  Fonts, numbering, spacing, indentations, and numbering restart options are 
available for each level.  To really start utilizing this, link each level in the multilevel list to 
the level of Heading in the document.  This triggers each heading to adopt the numbering 
that is formatted in the corresponding level and allows for easy selection of headings and 
their corresponding numbering within the document through selecting the heading, instead 
of manually numbering the headings or hope that autocorrect gets it right. 

Style Separator 



In general, paragraph and heading styles are mutually exclusive in the same “paragraph” 
in Word.  However, there is a little known tool that can actually separate these styles to 
create in-line headings, which are seen in a variety of contracts.  The “Style Separator” is 
hidden by default, but can be accessed through either (1) using the shortcut CTRL + ALT + 
ENTER, (2) searching for it in the search bar at the top of the Ribbons, (3) by adding it to 
your Quick Access Toolbar or () adding it your custom Ribbon options through the Word 
Backstage View à Options à Customize Ribbon menu. 

To use the Style Separator in an existing document, follow these steps: 

(1) If it is not already on, trigger the Show/Hide to be on. 
(2) Clear any styles you have on a target paragraph. 
(3) press ENTER after the heading that you want to apply your Heading Style to. 
(4) Apply your Heading Style to your heading. 
(5) Apply whatever Paragraph Style you prefer to the text that is to come after the 

heading. 
(6) Place your cursor after the heading and insert your Style Separator.  The paragraph 

text should then automatically “jump” up to your Heading. 

You are now on your way to using stylized in-line Heading Styles! 

Benefits of Using Heading Styles 
Now that heading styles are set and linked in a Multilevel List, there are side benefits that 
allow for easier navigation and editing of a document.   

Navigation Pane 
First is the Navigation Pane.  Selecting the View Tab in the Ribbon provides the option to 
turn on the Navigation Pane.  This is the same Pane that opens automatically when 
searching within a document, however, instead of defaulting to the “Results” tab of the 
Pane, the Pane automatically opens to the “Headings” tab.  All of the headings that are 
using heading styles in the document should now be visible.  Navigating to various 
sections of a document is as easy as clicking on the heading in the Navigation Pane, 
instead of the old scroll or page down/up method.   

Outline View 
Second is Outline view.  Again, in the View Tab, there is an option called “Outline”.  Instead 
of viewing the document in the normal “Print Layout”, this changes the view of the 
document into an expandable/collapsible outline view.  The options in the Outlining Tab of 
the Ribbon help for setting the various views of the outline.  Additionally, each section of 
text has either a plus sign or a gray circle.  Clicking and dragging these icons will move the 
entire section or selection of text, with all subparts until the same next level of heading or 
text block.  This allows for easily moving parts or whole sections of a document instead of 
copy/cut and paste.  Additionally, all of the numbering is automatically recalculated!  So, if 
there is an entire section of a contract or a legal brief that needs to be moved up or down in 



the document, a simple click and drag will accomplish this, instead of highlighting, cutting, 
pasting, and praying that everything worked.  

Tables of Contents 
Third is the ability to automatically generate a Table of Contents.  When Heading styles are 
in use, inserting a professional and accurate table of contents is just a few clicks away.  First, 
navigate to the area in the document that the table is to be inserted.  Then go to the 
Reference Tab and select the “Table of Contents” drop down.  As with the Multilevel lists, 
there are default tables that Word provides, however, selecting “Custom Table of Contents” 
will open the full Table of Contents menu.  In this menu, there are a variety of settings, 
including using Passim and the ability to select how many levels of headings are included 
in the table of contents. To gain greater control over exactly which headings will appear in 
the table of contents, select “Options” and then enter the corresponding levels for each 
heading; by default, each heading level that is indicated to be inserted in the table is already 
checked.  Click “OK” and the automatically generated table of contents appears, complete 
with the headings and corresponding page numbers.   

In the event that the formatting looks weird in the table, each level of in the table of contents 
has its own unique style.  As with all other styles, modifying is simple.  Open the Styles 
Pane, and select the desired style for each level: TOC 1 for level 1, TOC 2 for level 2, etc.  
Changing the fonts, spacing, etc., is just like modifying other styles.  The benefit of this is 
to change the look of a table of contents without having to change the look of the actual 
document. 

Additionally, if any changes are made to the document in a later time, updating the table of 
contents is a matter of a few clicks of the mouse.  If only content is added that would adjust 
the page numbers in the document, right click the table of contents and select “Update Field” 
and select “Update page numbers only”.  In the event there are substantive changes to the 
headings in the document, go through the same process, however, choose “Update entire 
table” when prompted. 

PDF Bookmarks Conversion 
Last is the ability to bookmark the headings in a document natively in a PDF.  Some courts 
require that all electronic filings have a readable PDF that has each heading bookmarked, 
so that judges can easily navigate through the PDF during hearings or on review.  Without 
using headings linked to heading styles, this was a tedious and manual process in Adobe 
Acrobat Pro or another PDF software.  Instead, using heading styles, this is simplified by 
saving the document as a PDF, selecting the “Options” button, and checking the option that 
states “Create bookmarks using – Headings”.  Select “Okay”, save the PDF, and voila!  A 
PDF formatted document is created with bookmarks already included! 

Cross-References 
Cross-references make it easy to automatically provide references in the text of your 
document to other parts or sections of a document.  When dealing with numbered sections 



and paragraph, instead of manually typing in “as provided for in Paragraph 12(b)”, insert a 
cross-reference in the document.  Doing so adds a field to the document linking the text of 
the field to the referenced area of the document. 

This way, when (not if) the paragraph that was originally Paragraph 12(b) moves and 
becomes Paragraph 11(b) because a new paragraph to the contract is inserted or a 
paragraph is moved in the document, the numbering can be automatically updated.  Doing 
this to each cross-reference, instead of manually going through a document later in time 
and updating each and every number when there is a change can save a host of time and 
prevent major errors. 

 

 

Conclusion 
Microsoft Word comes with a host of features that makes formatting long or complex 
documents a breeze.  While utilizing styles is probably the most important formatting 
feature to understand, there are many, many more!  Start exploring with this base 
information and start using this one tool (Word) as efficiently as possible.  Good luck! 
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